
  
    
  
Générer un G-code avec Cura

Pour l’exemple nous allons travailler avec le logiciel libre Cura, proposé par Ultimaker.

Au premier lancement du logiciel vous devez configurer Cura afin de lui indiquer le modèle de votre imprimante. Ensuite pour chaque projet, vous devrez indiquer la taille de la buse de votre imprimante, le matériau. Il existe même une application mobile pour vous aider.

Enfin, vous importez le fichier .STL fourni par Blender [File > Open File] ou via l’icône [image: ] 

Votre objet apparaît au milieu du plateau en tout petit (enfin, selon la taille de votre modèle et des propriétés d'export dans Blender). Sélectionnez-le afin de le déplacer sur le plateau, de lui attribuer une taille (par défaut en mm), de le pivoter, de l’inverser ou de le dupliquer.

Après des ajustements personnels, il est temps de vérifier que l’objet est bien imprimable.

[image: Modele Blender][image: modele]

[image: objet importé dans Cura]

[image: Manipulation des objets dans Cura]

Pour cela, il est habituel de vérifier que les couches se portent bien, que l’objet est bien fermé et que l’imprimante remplira correctement l’objet. Sur Cura la bascule entre la vue solide, et les vues X-ray ou Layer view s’alternent grâce au menu déroulant situé en haut à droite de l’interface.

Dans notre exemple, il s’agit d’un médaillon de diamètre de 70 mm et haut de 10 mm. Au centre en bas relief un R denté est visible et les lettres «ennes» sont en haut-relief. L’objet doit être remplis d’un «infill» un maillage interne automatiquement généré par l’imprimante de 20% afin d’assurer une solidité suffisante et une impression rapide.

Vérifions que l’infill est bien présent sur le médaillon, descendons à la couche 1 et remontons jusqu’à la dernière couche de notre objet, 102, au moyen de l’ascenseur situé sous le menu déroulant. 

[image: Visualisation des couches dans Cura]

[image: ]

[image: ]

Remontons pour vérifier le commencement du R. Puis terminons jusqu’à la dernière couche.

Cura calcule le temps approximatif  de l'impression. Cela peut vite prendre plusieurs heures selon les réglages.

Dernier détail important, en bas à droite, il s’agit du temps estimé d’impression de l’imprimante par le logiciel. Ce genre de détail peut modifier la taille de l’objet à imprimer ! Cette information est situé sur Cura en bas à droite.

Une fois tous les paramètres satisfaisant, il faut maintenant générer le fichier gcode en cliquant sur le bouton Save to file. Ce fichier gcode servira à fournir toutes les informations pour l’imprimante 3D. Placez-le sur la carte sd de l’imprimante ou envoyez-le lui via usb ou wi-fi.

[image: Export en Gcode]
Introduction

 
  Existant depuis plus de cinq décennies, mais essentiellement ancré dans l'industrie, le prototypage a évolué vers la technologie de l'impression 3D. Elle se voit de plus en plus vulgarisée avec l'apparition d'imprimantes 3D libre de source sur le marché . Il est donc effectivement possible de se procurer les plans d'une imprimante sous licence libre dans le but de la reproduire ou de s'en inspirer pour en faire un modèle personnalisé.

 
  Les objets 3D peuvent être conçus par nombre de logiciels de modélisation à travers un long procédé. Ce processus de prototypage se trouve accéléré en se tournant vers le logiciel Blender.

 
  Blender est un modeleur surfacique  à l'instar de Wings3D, Modo, Cinema4D, XSI, 3DSmax, Maya,  plutôt que paramétrique ou volumique comme FreeCAD, SolidWorks, Catia et Solid Edge entre autres.

 
  Structuré en trois grandes parties, ce livre s'adresse aux utilisateurs qui modélisent des objets avec Blender ou qui récupèrent des objets issus d'autres logiciels en vue de les imprimer.

 
  Une première partie intitulée "Créer dans Blender" permet au lecteur de pouvoir appréhender la méthodologie de création dans Blender et de pouvoir le prendre en main afin de réaliser un objet concret.

 
  La deuxième partie nommée  "Importer et modifier dans Blender" renseigne sur les étapes à suivre concernant l'importation de fichiers 2D ou 3D avec Blender, de même que leur modification.

 
  La troisième partie "Exporter pour l'impression 3D" met la lumière sur les diverses tâches à effectuer sur un maillage de sorte à effectuer son exportation pour l'impression.

 
  Dans l'optique de suivre et de répliquer aisément les exemples montrés dans le livre, il est préférable de garder l'interface de Blender en anglais.

Importer un modèle 2D

Ce n'est pas parce que la 3D existe que la 2D en est pour autant bannie. De nombreux fichiers n'ont actuellement de sens qu'en 2D (photos, logos...), mais peuvent avoir un intérêt à passer à la 3D, y compris à l'impression. Nous verrons dans ce chapitre comment importer des dessins vectoriels 2D ainsi que des images bitmap pour les utiliser dans Blender avant de les imprimer.

Importer un dessin vectoriel SVG

Dans de nombreux cas, il sera nécessaire de partir d'un dessin vectoriel 2D créé par un logiciel dédié comme Inkscape (téléchargeable sur le site officiel www.inkscape.org); ou de l'exporter à partir d'une autre application CAD. Les formats supportés par Blender pour l'import de fichiers vectoriels ne sont pas nombreux. Le seul qui soit spécifiquement implémenté est le SVG.

Le SVG (Scalable Vector Graphics) est une recommandation du W3C accessible en ligne à l'adresse http://www.w3.org/TR/SVG/. Une traduction en français un peu ancienne est disponible sur le site http://www.yoyodesign.org/doc/w3c/svg1/. Le SVG est en constante discussion depuis 1998. La première recommandation basée sur une proposition d'Adobe est parue en 2001 et a depuis subi plusieurs mises à jour partielles. SVG a été conçu pour être un format d'échange universel, pratique à utiliser sur le web ou web. Les fichiers SVG sont de la famille XML, composée d'un fichier texte interprétable et modifiable ; lisible par tout navigateur web. Le SVG s'impose peu à peu comme un format d'échange important, mais aussi comme un format de publication par défaut pour les dessins vectoriels, en particulier dédiés à l'édition électronique. Encore rare il y a quelques années, il fait maintenant partie de la boîte à outils de tout logiciel performant et Blender n'échappe pas à la règle.

Ainsi, même si Blender dispose d'outils permettant d'éditer des courbes de Béziers ou autres formes de courbes vectorielles, les fichiers fournis au format SVG réalisés dans d'autres logiciels seront fréquents et surtout ces logiciels peuvent fournir des outils bien plus pratiques dans le dessin 2D que Blender lui-même.

En général, les formes ainsi importées dans Blender seront extrudées, parfois combinées à d'autres formes, selon les besoins et les objectifs.

Dans l'exemple suivant, nous partirons du logo de FlossManuals francophone conçu en deux couleurs, et pour faciliter l'utilisation dans Blender, nous avons combiné toutes les formes de même couleur entre elles.

[image: Logo de base en SVG dans Inkscape]

Dans un nouveau fichier Blender, supprimez le cube par défaut, placez-vous en vue de dessus [NumPad 7] ou [View>Top] pour mieux voir ce qui va être importé.

Allez alors dans [File>Import>Scalable Vector Graphics (.svg)]. Naviguer alors les dossiers pour récupérer le fichier SVG. Il apparaîtra alors au centre de la scène. Sa dimension sera peut-être trop petite pour le voir correctement. N'hésitez pas à zoomer.

[image: Logo SVG importé dans Blender]

Si nécessaire, dé-zoomez pour voir l'intégralité de la scène puis placez la souris au plus près de l'origine (petit rond orange). Sélectionnez l'ensemble des formes et mettez le logo à une échelle correcte manuellement en mode édition avec [S] et en éloignant progressivement la souris. Vous pouvez vous y reprendre en plusieurs fois et déplacez-le si besoin avec [G].

Nous avons ici l'impression que le texte a disparu, mais un affichage rapide en mode filaire [Z] nous montrera qu'il est bel et bien présent. En passant en mode Édition, nous voyons les courbes de Bézier apparaître. Il est alors possible d'adapter la forme si besoin en manipulant les poignées.

[image: Lobjet importé en mode filaire][image: Les courbes récupérées du SVG]

Sélectionnez maintenant la forme noire avec un clic droit [RMB] et dans le panneau de propriété Path, à droite de l'espace 3D, augmentez légèrement le réglage Extrude en le passant par exemple à 0.002. Vous ne voyez pas encore les modifications. Passez en vue de face [NumPad 1] ou de côté [NumPad 3] et voyez l'épaisseur extrudée. Celle-ci sera très claire en mode filaire [Z].

[image: Extrusion de courbe dans Blender]

Sélectionnez alors le texte et extrudez-le de la même façon en passant le réglage à 0.003 ; on peut voir que la partie blanche du logo représentant le livre est extrudée simultanément conformément à la préparation de notre fichier dans Inkscape.

Tout cela est bien, mais en y regardant de plus près un petit problème se pose : repassez en affichage solide [Z] et allez en vue de côté [NumPad 3] ou orthogonale [NumPad 5]. On peut voir que la forme a été extrudée des deux côtés de la courbe 2D, ce qui fait que la forme blanche et la forme noire ne sont pas alignées au sol l'une avec l'autre. Si cette configuration est possible, il ne faudra pas oublier de repositionner [G] éventuellement les formes pour les aligner correctement d'un côté.

[image: Alignement de courbes extrudées dans Blender] [image: Logo final en 2 couleurs extrudées]

Exporter directement des objets courbes de bézier ne donnera pas un modèle exploitable pour l'impression. Il est nécessaire préalablement de les convertir en maillage, afin de pouvoir nettoyer le modèle avant l'export. 
Pour cela en mode objet, utilisez le raccourci [Alt C] et cliquez sur le deuxième choix Mesh from Curve/Meta/Surf/Text. 
Mais on s'aperçoit en edit mode que le maillage généré par la conversion n'est pas manifold. 
[image: Non manifold object in blender]

Ce problème peut être résolu rapidement en fusionnant les vertex des parties frontales et ceux des parties latérales situés à la même position. 
Il suffit de tout sélectionner avec la [touche A] et de supprimer les doublons avec l'outil Remove Doubles [W]. 
[image: ]

Et le résultat est un maillage fermé où les vertex sont communs aux parties frontales et latérales. 
[image: Objet manifold]

Il vous reste à faire de même pour l'autre objet courbe.

[image: Logo fmfr imprimé]

Pour une impression bicolore sur une imprimante avec deux extrudeurs,  chaque couleur est à exporter en tant qu'un fichier .STL propre, afin d'être plus facilement géré par le logiciel de l'imprimante. 
 Pour la mise à l'échelle et la procédure d'exportation, se référer au chapitre Exporter en .STL ou .OBJ.

Utiliser un bitmap pour modifier son maillage

Pour imprimer des objets au relief assez complexe, ou riche, il n'y a pas méthode plus rapide que d'utiliser une texture issue d'une image, de type photo ou dessin scanné. Cette image sera de préférence enregistrée au préalable en niveaux de gris car Blender n'en exploitera que les valeurs et pas les couleurs. Les variantes de gris seront alors utilisées pour modifier l'épaisseur du maillage grâce au modificateur Displace.

Nous utiliserons ici l'image https://en.wikipedia.org/wiki/Lithophane

Nous allons utiliser ce principe pour modéliser une lithophanie dont les variations d'épaisseur serviront de décoration lumineuse.

Afin d'importer l'image comme un objet physique dans Blender, il est plus simple d'utiliser l'add-on "import-export: Images as Plane". Rendez-vous dans [File>User Preferences] et activez-le. 
Allez ensuite dans [Add > Mesh > Images as Plane] et sélectionnez votre image.

[image: Images as Plane : import image in Blender]

Revenez sur la vue 3D et passez en mode Édition [TAB]. Pour réaliser une lithophanie, une image en noir et blanc déplacera le maillage subdivisé grâce à un modificateur. Afin de définir un cadre plan, non affecté par la mise en relief, ultérieurement,  il est nécessaire d'extruder les arêtes du pourtour du plan [Alt E > Edge Only]. Par défaut, l'extrusion est couplée avec une opération de déplacement. Ici, la translation n'est pas souhaitée. Faîtes un clic droit pour l'annuler.

[image: ] Il faudra certainement passer l'affichage en mode Texture pour voir l'image dans Blender

[image: Base de lithophanie]

Désormais, il faut éloigner le pourtour extrudé du cadre par un agrandissement [S] très léger d'une valeur de 1.01.

Pour plus de clarté, l'agrandissement  a été éxagéré sur la capture d'écran suivante.

 

Sélectionnez maintenant la face centrale; l'objectif étant de limiter l'effet du déplacement de vertex  par notre image à cette face. Vous devez pour cela créer un vertex group:

 

[image: Lithophanie en place]

Dans les propriétés du maillage, onglet vertex groups, cliquez sur le [+] puis [assign]. 

Sélectionnez  l'intégralité des vertex [A][A] et mettez votre objet à la taille à laquelle vous voulez l'imprimer [S] et mettez les normals vers l'exterieur avec le raccourci [Ctrl + N].

Sortez du mode Édition [Tab].

Tout comme les pixels de l'image définissent sa qualité de résolution. Désormais, il faut densifier le maillage. Allez dans les propriétés des modificateurs et ajoutez un modificateur Multiresolution, sélectionnez Simple, cliquez sur subdivide 7 fois. A chaque niveau de subdivision, chaque face est subdivisée en 4 nouvelles faces. 7 subdivisions suffisent pour les images avec peu de détail.

[image: Multires modifier]

Ajoutez un modificateur [Displace]; sélectionnez votre image dans texture ainsi que le groupe précédemment créé dans vertex group et dans [Texture Coordinates] sélectionnez [UV]. 
Augmentez enfin la valeur absolue [strength] pour avoir un volume satisfaisant. 
Le modificateur pousse les blancs vers le haut et les noirs vers le bas. 
Puisque notre image n'est pas un négatif, il faut que la valeur strength soit négative pour inverser ce comportement. 
Passez la valeur midlevel à 0 pour que rien ne soit au dessus du cadre. Cette valeur par défaut à0.5 permet de régler le niveau à partir duquel commence la mise en relief.

[image: Displace modifier][image: Displace appliqué]

Le niveau de subdivision du modifier Multiresolution peut être plus poussé pour un meilleur respect des détails. Cependant cela signifie que le nombre de faces du modèles va passer de plusieurs centaines de milliers de faces à plusieurs millions. Hors à ce niveau, suivant votre configuration, le modèle peut être lourd à gérer. Avec l'image utilisée, nous l'avons poussé jusqu'à 9.
 

Repassez en edit mode et sélectionnez uniquement le pourtour de l'objet [Shift Ctrl Alt M]. D'abord extrudez-le et agrandissez-le comme précédemment mais avec une valeur de 1.1 pour définir le cadre de la lithophanie.

[image: Lithophanie maintenant noire]

Le maillage à 9 niveaux de subdivision est tellement dense qu'il apparaît noir. Seules les faces étirées du cadre laissent apparaître des mailles. Il peut paraître plus simple de faire les extrusions avant d'appliquer les modificateurs. Mais dans ce cas, beaucoup plus de faces inutiles vont alourdir le maillage. 
 
[image: Niveau de lithophanie]
Grâce à la valeur midlevel à 0, le déplacement s'est fait sous le cadre. Pour un déplacement avec une force positive, il aurait fallu mettre la valeur midlevel à 1.

Extrudez maintenant vers le bas pour donner une épaisseur à votre objet (pas trop pour laisser la lumière transparaître mais suffisamment pour lui donner assez de solidité).

Enfin, refermez l'ouverture du maillage en faisant un Fill [Alt F] plutôt qu'un Grid Fill générant plus de faces. 
[image: Fill du lithophane]
Analyser son maillage

L'analyse du maillage est une étape très importante. En effet, il ne suffit pas d'avoir un beau modèle, il faut aussi que celui-ci convienne à l'imprimante 3D. En effet, l'imprimante va devoir interpréter le modèle 3D, et, de là, le découper en autant de plans que nécessaire, calculer où mettre le matériau, quel chemin parcourir, savoir si une zone sera autoportée ou pas... Tout cela rend les choses particulièrement complexes et de nombreux jolis modèles que l'on trouve sur le web ne sont pas toujours imprimables.

Blender dispose de deux outils d'analyse de maillage destinés à l'impression 3D : Mesh Analysis et 3D Printing Toolbox. Ces deux fenêtres ont quelques paramètres identiques, mais la première est la plus simple à prendre en main. Elles nous aideront toutes deux à trouver de potentielles erreurs sans être exhaustives. 

Le mode de visualisation "Mesh Analysis" 

 Le panneau d'analyse de maillage est disponible en mode Édition dans les propriétés [N] avec un affichage solid.

 [image: ]

[image: ] 
 
Cet onglet permet d'activer différents types d'analyse du modèle en mode Édition. 
N'étant pas compatible avec les modificateurs, vous devez soit désactiver vos modificateurs mais dans ce cas leur action sur le maillage ne sera prise en compte, soit les appliquer (clic sur le bouton [Apply] dans la fenêtre de chacun des modificateurs).

Il colore les faces incriminées de variations de couleurs allant de bleu à rouge selon les limites configurées. 
Il dispose de 5 types d'analyse: 

	Overhang
	permet de visualiser les faces dépassant l'angle paramétré par rapport au sol, afin de réaliser des modèles avec le moins de supports nécessaires; dans le cas du mug, les parties sortant de la forme de base, bec et anse, posent clairement problème. 
[image: ] 
	Thickness
	met en évidence les faces dont l'épaisseur peut poser problème. Il s'agira de paramétrer le minimum et le maximum d'épaisseur selon les besoins définis à l'impression et d'en anticiper les problèmes. Dans l'exemple, on peut voir que l'épaisseur est calculée selon l'orientation de la face. Ainsi, la face supérieure de la tasse est considérée comme épaisse au vu de toute la matière placée en dessous. En revanche, le bec, juste créé avec une arête déplacée manque réellement d'épaisseur. Il faut aussi avoir en tête que l'imprimante n'imprime pas nécessairement la totalité d'une épaisseur, par économie de matière première. 
[image: ]

Le minimum peut par exemple être contraint par le diamètre de la buse, même si les imprimantes sont de plus en plus précises et apprennent aussi à s'adapter à ces situations.
Intersect	pour visualiser les faces qui se croiseraient  (notre mug ne contient pas de croisement de faces, nous changeons donc de modèle). Cela pourrait être fréquent pour des objets plus complexes (modèles de personnages par exemple). Le singe par défaut de Blender est constitué de croisement au niveau des yeux. 
[image: ] 
	Distortion
	affiche les faces non planes (un ngon* dont les vertices ne seraient pas sur le même plan); une fois encore, le bec et la base de l'anse constitue des zones de déformation à regarder avec attention au moment de l'impression. Il est important de bien noter les angles à analyser selon la résistance des matériaux utilisés et la capacité à supporter leur propre poids. Plus l'angle de déformation est élevé plus la difficulté à imprimer sera grande si la projection est volumineuse. 
[image: ] 
	Sharp
	affiche les angles trop aigus. Ce seront des points à vérifier à l'impression parce que le taux de précision nécessaire et la fragilité peuvent impacter le résultat. 
Dans ces situations, il pourrait être judicieux de rajouter quelques vertex qui permettront de contrôler l'épaisseur localement. [W > subdivide], [Ctrl E > Edge Slide] et [GG] en mode édition peuvent aider à positionner un point, ou le loop cut [Ctrl R], en encore le couteau [K] permettre des découpes plus larges. 
[image: ] 


L'add-on 3D print toolbox

Apparu dans la version 2.67 de Blender, cet add-on complète le panneau Mesh Analysis et permet d'avoir une vue plus globale de l'ensemble des problèmes. 

En cliquant sur le bouton relatif à un test (celui qui contient le nom, par exemple Thickness), le résultat d'analyse apparaît alors en bas avec le nombre de faces répondant au critère. Cliquez alors sur cette zone de résultat pour sélectionner automatiquement les faces.

[image: ] 

[image: ]

	Volume
	calcule le volume de son objet.
	Area
	calcule la surface de son objet (utile pour les impressions céramiques où les prestataires calculent le prix par rapport à celle-ci).
	Solid
	indique si le maillage est "non manifold" (volume non fermé) et si les normals sont dans le bon sens, permet également de sélectionner automatiquement les vertex incriminés.
	Intersections
	indique si des faces se croisent.
	Degenerate
	met en évidence les faces qui feront une taille nulle, ce qui poserait des soucis sur certains logiciels.
	Distorted
	indique les faces non planes.
	Thickness
	indique les murs dont l'épaisseur est inférieure au paramètre saisi
	Edge Sharp
	montrant les angles trop aigus.
	Overhang
	pour les faces dont l'angle par rapport au sol est inférieur au paramètre.
	Check All
	pour faire une vérification sur tous les paramètres ci-dessus et peut constituer une première approche pratique pour faire une évaluation générale.
	Isolated
	supprime les vertex qui n'appartiennent pas à un volume et évitera d'imprimer des formes non nécessaires.
	Distorted
	pour supprimer les faces non planes
	Scale to Volume
	modifie l'échelle de l'objet afin de lui donner un volume précis
	Scale to Bounds
	modifie l'échelle de l'objet afin de lui donner une longueur maximum
	Export Path
	permet d'exporter l'objet sélectionné, les 2 boutons permettent d'appliquer l'échelle à l'export pour le premier et d'ajouter les mapping d'image dans le but des impressions en quadrichromie (Zprinter de chez Zcorp) pour le deuxième.


3D Printing Toolbox complète admirablement [Mesh Analysis] : 

 


	contient plus d'options et affiche les quantités

	travaille avec les modificateurs activés ce qui rend les corrections plus faciles, mais les résultats gagneront tout de même à être effectués sur des modificateurs appliqués

	permet de sélectionner directement les faces

	et aussi de fonctionner en mode filaire ce qui permet d'accéder à des éléments invisibles comme dans ce cas de l'[intersect] apparaissant à la base du mug qui n'était pas évident avec Mesh Analysis. 
[image: ] 


Prise en main rapide

Blender peut sembler déroutant à l'ouverture. Ce chapitre va vous guider dans sa prise en main.

Interface

L'interface de blender est extrêmement modulable. Cela permet de l'adapter à son travail mais c'est également déroutant pour les néophytes. L'espace de travail modifié au chapitre précédent contient 3 éditeurs :


	la vue 3D qui prend le plus d'espace.

	l'outliner qui est un descriptif du contenu du fichier.

	l'éditeur des propriétés. Vous y modifierez les données de la scène ou celles de l'objet.



Blender utilise d'autres éditeurs sans lien avec l'impression 3D pour des tâches spécifiques comme l'animation ou le montage vidéo. Cependant, pour colorer ou modifier un objet, vous pourrez être amené à aussi utiliser l'UV/Image Editor présent dans l'écran UV editing.

[image: ]

Pour changer la nature d'un éditeur, il suffit de cliquer sur l'icône de l'éditeur présent dans son header à gauche.

Tapez la combinaison [Maj Espace] pour maximiser ou minimiser un éditeur.

[image: Différents panneaux de Blender]Cliquez sur l'icône correspondant au type de données à modifier. Les informations affichées dans l'interface s'adaptent d'après l'objet actif sélectionné.

Dans l'outliner, cliquez sur le nom d'un objet pour le sélectionner.


	Cliquez sur l'œil pour masquer un objet dans la vue 3D.

	Cliquez sur la flèche pour empêcher la sélection de l'objet dans la vue 3D.
[image: Vue de l'outliner de Blender]





La vue 3D comporte deux colonnes latérales.


	La colonne de droite, celle des propriétés de la vue, peut être masquée/affichée avec la [N].
On y gère l'affichage dans la vue 3D (grille , panneau Mesh Analysis).



	La colonne de gauche, celle des outils, peut être masquée/affichée avec [T].
les outils de modélisation y sont accessibles sous forme de boutons cliquables. Les panneaux add-ons utiles pour l'impression 3D s'y affichent également.



	la colonne de gauche contient également une région en bas pour modifier les paramètres du dernier outil utilisé.



Les panneaux présents dans les colonnes comme les outils sont spécifiques.

[image: ][image: ][image: ]

À gauche, la colonne d'outil en Object Mode. À droite, la même colonne en Edit Mode.

Les modes

[image: ]

Suivant la modification apportée à un objet, les manipulations seront à effectuer dans le mode dédié.


	Mode objet (object mode) : c'est le mode par défaut. Il sert à pratiquer des transformations de base (déplacement, rotation). Passer en Object Mode peut être considéré comme une validation des modifications faîtes dans un autre mode.

	Mode d'édition (edit mode) : ce mode comprend le plus d'outils de création et modification de la géométrie. C'est dans ce mode que se fait le nettoyage du maillage final.

	Mode de sculpture (Sculpt Mode) : il permet de générer ou affiner le maillage comme si on sculptait dans de la glaise.

	Mode de peinture de vertices (Vertex Paint): on y peint à une résolution limitée à la géométrie de l'objet. Une couleur est stockée pour chaque vertex. C'est une technique plutôt utilisée pour le jeu vidéo. Ce type de couleur n'est pas supportée pour les impressions couleur.

	Mode de peinture de texture (Texture Paint) : il permet de peindre dans la vue 3D un fichier image appliqué à la surface de l'objet par le biais des coordonnées UV. Le fichier image de la texture sera exploité pour l'impression des couleurs.

	Mode de peinture de la pondération (Weight Paint) : c'est un mode indispensable à la réalisation d'animations pour le cinéma ou le jeu vidéo.. Mais à moins de s'en servir pour la création de vertex groups pour limiter l'influence d'un modificateur, il n'a pas d'intérêt pour l'impression 3D.



Se déplacer et manipuler dans la vue 3D

Dans Blender, le bouton droit de la souris est utilisé pour sélectionner les éléments. Le bouton gauche sert à déplacer le curseur 3D, valider les actions ou à définir des tracés de peinture ou de sélection. Et la molette de la souris  est utilisée comme un troisième bouton pour pivoter, se déplacer ou zoomer dans la vue.

Faire un clic maintenu sur la molette pendant que vous déplacez la souris pour tourner autour d'un objet. Faire le même genre de clic mais en maintenant la touche Shift enfoncée en même temps pour déplacer latéralement la vue sans changer l'orientation du point de vue. Faire la même chose mais en maintenant la touche [Ctrl] enfoncée pour zoomer ou dézoomer suivant le sens du déplacement de la souris.

Utilisez les touches du pavé numérique pour remettre la vue 3D dans une vue standard :


	vue de face (Front) : 1

	vue arrière (Back) : Ctrl

	vue de droite (Right) : 3

	vue de gauche (Left) : Ctrl 3

	vue du dessus (Top) : 7

	vue de dessous (Bottom) : Ctrl 7



[image: Vues 3D dans Blender]

[NumPad 5] du pavé numérique permet basculer d'une vue perspective à une vue orthographique.

[NumPad 2], [NumPad 4], [NumPad 6] et [NumPad 8] font pivoter la vue de quelques degrés dans le sens de la flèche qui leur est associée.

[NumPad .] du pavé numérique recadre la vue au niveau de l'objet sélectionné.

[Home] recadre la vue pour englober tous les objets de la scène.

La vue orthographique activable à la touche 5 permet d'obtenir des résultats plus précis dès lors qu'on travail au moins avec 2 vues perpendiculaires

La combinaison [Maj C] fait la même chose mais recentre également le curseur 3D aux coordonnées (0,0,0). Le curseur 3D se déplace facilement en faisant un clic gauche dans la vue 3D.

La combinaison [Maj B] appelle l'outil de zoom sur une région rectangulaire à définir par un clic gauche lors du déplacement de la souris  en encadrant la zone sur laquelle vous souhaitez zoomer.

[image: Navigation 3D dans blender]

[B] appelle un outil identique mais pour sélectionner les éléments présents dans la zone rectangulaire définie.

[A] permet de tout sélectionner ou désélectionner.

Placer la souris au-dessus d'un élément et faire un clic droit permet de le sélectionner. Refaire la même manipulation mais avec la [touche Shift] permet d'étendre la sélection à un second élément ou de désélectionner un objet en conservant le reste de la sélection.

Les 3 transformations de base sont :


	la translation (Translate [G]),

	la rotation (Rotate [R]),

	et la mise à l'échelle (Scale [S]).



Elles peuvent également être effectuées grâce au manipulateur correspondant.

[image: Utilisation de la mise à l'échelle dans Blender]

Pour valider certaines actions, un clic gauche ou une pression sur la [touche entrée] peut être nécessaire. Au contraire, pour annuler une manipulation en cours , il faut utiliser [Echap] ou faire un clic droit.

Blender utilise aussi des raccourcis clavier standard : [Ctrl Z] pour annuler une action validée, [Ctrl N] pour un nouveau fichier, [Ctrl O] pour ouvrir, [Ctrl S] pour sauvegarder, [Ctrl C] pour copier et [Ctrl V] pour coller.

Si vous souhaitez récupérer un objet à partir d'un fichier .blend destiné à de l'illustration; décochez la case Load UI dans la toolbox évite de lancer l'interface du fichier pour conserver la vôtre définie pour l'impression 3D. 
[image: ]
Où imprimer ?

À présent que le fichier est soigné, il est prêt pour la prise en charge par la machine. Quelques services d'impression en ligne apparaissent aujourd'hui, aussi bien sur le web qu'au coin de la rue. 

Sur le web

Les spécialistes 

Les incontournables du web marchand sont i.materialise, sculpteo, shapeways et cubify. Il s'agit ici de spécialistes offrant sur le web divers procédés et divers matériaux. La prestation est soignée, il en va de la réputation du "Cloud Printing", l'impression 3D déportée «en nuage» qui repose sur des plate-formes physiques, implantées sur tous les continents. Ces outils en ligne tendent à rendre le processus le moins douloureux possible pour l'usager, et l'expérience agréable. Un transfert de fichier et un calcul de prix selon le matériau et la dimension choisie, et l'affaire sera réglée et livrée sous quelques jours par la Poste, si besoin par transporteur. Les matériaux et les frais de port aidant, ces services sauront d'autant satisfaire l'utilisateur livrant un .stl impeccable car les "ratés" coûtent chers. Les formats supportés sont nombreux et varient selon les sites marchands. Le .stl et le .obj restent toutefois les plus universellement intégrés. Format supportés - http://www.shapeways.com/tutorials/supported-applications?li=nav 

capture d'écran objets différentes couleurs/ différents matériaux. 

Les matériaux sont plus ou moins les mêmes au menu des diverses offres commerciales. On retrouve les plastiques blancs ou colorés, et dont les propriétés vous offrirons divers niveaux de finition, l’Alumide, mélange de polyamide et de fines particules d’aluminium permettant d'obtenir des pièces particulièrement résistantes, les cires, par exemple pour les tirages "à la cire fondue" que l'on retrouve souvent en bijouterie, les résines, qui se destinent plus particulièrement aux rendus métallisés ou plaqués de métaux précieux par la suite. Certains vous proposeront aussi de la céramique (par émaillage à chaud d'une pièce imprimée). Il y en a pour tous les goûts et vous devriez pouvoir y trouver votre bonheur. Vous adapterez la résolution de votre modèle en fonction de la destination de l'objet final. Nul besoin de transférer un fichier aux millions de facettes s'il s'agit d'un tirage céramique, qui sera un peu lissé naturellement par le procédé utilisé. 

Les généralistes 

Sur le même modèle mais plus généraliste, vous trouverez le Néozélandais Ponoko, service de fabrication étendu qui propose, toujours depuis votre clavier et à l'international, découpe & gravure laser, impressions et même prototypage électronique. Son partenariat avec Formulor (DE), Vectorealism (IT) et RazorLab (UK) lui permet d'être présent en Europe, celui avec Sparkfun (US) ajoute au site la possibilité d'intégrer de l'électronique à votre projet. Son rapprochement avec le fabriquant de fraiseuses à commande numérique shopbot élargi encore son offre en proposant une communauté de plus de 600 professionnels capables de réaliser votre demande. L'idée de 100K Garage consiste à vouloir faire circuler des idées plutôt que des objets physiques, réalisés localement. De quoi savoir faire et le faire savoir... 

La magie du web offre aussi le service http://www.3dhubs.com/#about.Le principe, dans les grandes lignes, consiste à mettre du temps d'impression sur le marché des utilisateurs. En référençant ses machines, autrui peut louer son service à un tiers, devenant le temps d'une impression, une sorte de mini usine. Ce choix pourrait aussi s'avérer judicieux pour produire rapidement et en quantité une pièce identique, en opérant de manière parallélisée. Imprimantes de tous les pays, unissez-vous !

 L'initiative nord américaine «100K Garages», un réseau décentralisé de professionnels ayant à disposition une fraiseuse numérique (bois principalement), permet d'offrir  <<a decentralized network of shop-bot manufacturers in North America>>.

La longue traîne des objets 

En explorant plus avant les sites web suggérés, vous remarquerez que certaines de ces plate-formes jouent pleinement des options ouvertes par le web et proposent aux auteurs de modèles 3D de devenir revendeurs de leur production imprimée. Grâce aux plus abouties de ces plate-formes, s'offre à vous la possibilité de vendre des objets embarquant même de l'électronique. Devrions nous parler d'artisanat à la sauce 2.0 ? 

En guise de dessert, le Sugar Lab saura peut être vous satisfaire. Reste à savoir si l'addition est aussi soluble que cette prestation est sucrée ? 

Au coin de la rue 

